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1 OVERVIEW
WaLRUS II is a second-generation buoy radiometer system that measures spectral irradiance and
radiance in-situ, in a manner that is proven to
provide the best determination of water-leaving
radiance and remote sensing reflectance.
WaLRUS II measures the solar irradiance
spectrum incident on the ocean surface, and the
upward reflected radiance 60 cm below the surface, simultaneously and with high spectral resolution over a range of at least 350 to 850 nm. In
addition, WaLRUS II may be configured with
additional light collectors and spectrometers to
measure other simultaneous radiances and irradiances above and below the water surface.
Though ideally suited measurements
while floating at the surface of the water, WaLRUS II can also measure underwater at depths up
to 100 meters, either at a fixed depth or while
profiling.
Data from all channels are delivered
through a neutrally-buoyant tether cable for realtime display on a computer. The internal intelligent controller can also store data in on-board
flash memory for later retrieval.
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2 QUICK START
Unpacking and Handling
Figure 1 shows some key features of WaLRUS II, in its baseline configuration. Your WaLRUS
II may have different features.
WaLRUS II is shipped in a rugged custom
shipping case. The Power/Data Interface (PDI) cable, tether cable, software CD and other accessories
are shipped in a separate case.
While lifting WaLRUS from its case and handling it, you may use the protective ring near the top
as a hand-hold. Stand the WaLRUS upright on its
foot, as in Figure 1, or lay it on the flat side of the
ring and foot as shown in Figure 2.
WaLRUS is shipped with a protective dummy
plug installed on the power & data, and covers on the
light collectors. Leave the plug and covers in place
until you are ready to collect data.

Protective
ring

Irradiance
(Ed) collector

Radiance
(Lu) collector
Power & data
connector

Tether
attachment
eye

Pressure
sensor

Software Installation
Insert the software CD in your Windows
computer, and run the RadSoft installation program.
If your WaLRUS will be used in both surface
and profiling modes, it is supplied with two different
calibration files. To install these:
• Start RadSoft.
• Select About RadSoft from the Help menu.
• In the “About” box, click the link under User
Files. This will open a Windows explorer
window.
• Double-click the HydroRad folder.
• Double-click the Calibration folder.
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Figure 1. WaLRUS Overview
(baseline configuration shown)

•

Drag the files WRxxxxxx_surface.csv and WRxxxxxx_profile.csv (where xxxxxx
is the serial number of your WaLRUS) from the
Calibration folder on the software CD into the
Calibration folder on the computer.

USB Interface Installation
•
•
•

•

Plug the HOBI-supplied RS232-USB interface
into your computer.
Allow Windows to automatically install the
driver.
If Windows cannot install the driver automatically, go to http:// www.ftdichip.com/ Drivers/
VCP.htm and download the driver applicable to
your Windows version.
You may need to reboot your computer before it
recognizes the interface.

Startup
•
•
•
•
•
•

•

Figure 2. WaLRUS resting
safely on its side, with the topmounted Ed collector and protective plastic ring in the foreground

Connect the beige-colored branch of the PDI
cable to the RS232-USB interface.
Remove the dummy plug from the power & data interface connector (see Figure
10). Store it in a safe place for later use.
Plug the waterproof connector of the power/data interface (PDI) cable into WaLRUS. Tighten locking sleeve.
Connect the battery charger to the PDI cable.
In RadSoft, select Connect from the File menu.
In the Connect To Instrument dialog box, click Find port & baud rate. Leave all
settings at their defaults; RadSoft will detect the instrument type.

RadSoft will scan its ports until it finds the WaLRUS. If this is the first time you
have connected to the instrument, it will display a message indicating you must
select a calibration file. Click OK, then navigate to the WRxxxxxx_surface.csv
file you installed in the Quick Start section.
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•

When the connection is established, and icon representing the WaLRUS will appear in the RadSoft Desktop window (appearance may vary with software version):

•

Double-click on the icon. This will open a terminal window in which you can observer the commands being sent to the WaLRUS, and its responses.
Select Set Date/Time from the WRxxxxxx menu. In the dialog box shown below,
click Set WRxxxxxx To PC Date & Time.

•

Data Collection
•

Select Set Up Acquisition… from the WRxxxxxx menu, to see the following dialog box. Copy the settings shown below (the list of channels may vary depending
on the configuration of your WaLRUS).
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•

In the same dialog box, select the Radsoft Processing tab, and enter the following
settings:

•

Select the Exposure tab, and select the “Auto Speed” option. Leave all other settings at their defaults.
Remove covers from the WaLRUS light collectors.
Note the data sampling controls in the toolbar:

•
•

Sample Once

Stop Sampling
Sample
Continuously

•

Click the
button, or select Acquire One Sample from the File menu.
Commands and WaLRUS responses will appear in the terminal window, and a
graph will appear and display spectra. The amount of time required for this process may be up to 30 seconds, depending on light levels.

•

Click the
button or select Acquire Continuous Samples from the File menu,
and note that multiple samples are collected and added to the graph. If desired,
shine lights into the different collectors to observer their responses.

•

To stop sampling, click the

button or select Stop from the File menu.
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Data Retrieval
•
•

•

To display files stored on the WaLRUS, select Device Explorer from the File
menu, or click the
button.
If you followed the steps in the Quick Start section, you should see files called
TESTA.BIN, TESTB.BIN, etc. and TEST.TLT. The BIN files contain spectral
data from the WaLRUS channels. The TLT file contains tilt/roll/heading data
synchronized with the spectral data.
To transfer the files to your computer, drag their icons from the RadSoft Explorer
window to a Windows Explorer folder. You can then open the spectrum files in
RadSoft.

RadSoft Operation Details
For complete details on all RadSoft commands and operations, see the separate
RadSoft User’s Manual.
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3 PRECAUTIONS
General
•

Also see section 8: Maintenance, Service and Support

•

If deploying in salt water, rinse the WaLRUS and tether thoroughly with fresh
water after each use.

•

Dry before storing.

•

Check the condition of the zinc anodes on the bottom end cap (see Figure 12 in
section 8).

Electrical Connectors
•
•

Lightly lubricate the connectors on the WaLRUS and tether with silicone grease
or spray.
Protect the connectors with dummy plugs when not in use.

Light Collectors
•
•

Cover the light collectors when not in use.
Clean and dry the collectors before covering.

Tether Cable
•
•
•
•

Connect tether properly to avoid strain on electrical connector (see section 4.2.1).
Prevent kinks and sharp bends in the tether
If running tether through pulley or sheave, use a diameter of at least 30 cm.
Do not load the tether with more than 50 kg.

Batteries
•
•

Store and ship the WaLRUS with the battery-disconnect dummy installed (see
section 5.2.4)
Fully charge the batteries at least once every two months.
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4 DEPLOYMENT
4.1 Overview
WaLRUS II can be deployed in a surface-float
mode, or in profiling mode. Both modes use a “stability
weight” suspended from the bottom pad eye to provide
proper attitude and floating depth (see Figure 3). In profiling mode, additional weight is suspended below the stability weight, to provide the desired sink rate.
The lengths of the ropes used for the stability
weight and, if it is used, profiling weight, can be adjusted
according to the deployment method and the height above
the water from which the WaLRUS is deployed. See section 4.4 for more details about rigging of the ropes and
weights.
Ideally, WaLRUS would be raised and lowered with
a davit or crane. But it can be deployed directly by hand,
with two or more people.

Figure 3. WaLRUS floating at proper depth

NOTE: the WaLRUS tether cable is strong enough to lift the WaLRUS and
its weights, but must not be bent to a radius of less than 15 cm when holding weight.
If deploying with a davit or crane, use a pulley or sheave of at least 30 cm diameter.

4.2 Surface Deployment
4.2.1 Tether connection
•
•
•

Figure 4 shows correct attachment of the tether.
Loop the cable around the WaLRUS to prevent strain on electrical connection.
Tighten locking sleeve on electrical connector.
Connect the cable grip to pad eye with a locking carabiner. Be sure to lock the
carabiner!

4.2.2 Preparation
• The rope on the stability weight should be long enough to lower the weight into
the water while the WaLRUS is on the deck of the ship. If necessary, adjust it.
• Have tether in a neat coil or figure-8, and ready to pay out without kinks. Assign
cable-handling responsibility to one person.
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•
•

Test data communication.
Set data collection parameters in RadSoft,

4.2.3 Deployment
• Move WaLRUS and stability
weight to deployment site.
• Use locking carabiner to secure profiling weight to bottom pad eye on WaLRUS
(Figure 5).
• Set the WaLRUS on deck, at
the place where it will be
lowered into the water.
• While two people hold the WaLRUS securely on the deck, one person gently
lowers the stability weight into the water
(Figure 6). Do not let the weight
drop.
• The person who lowered the stability
weight now assists in lowering the
WaLRUS into the water.
• To avoid ship shadow, let the WaLRUS drift away from the ship while
paying out a length of tether.
• Use start button in RadSoft to start
data collection (if using a HydroRad-E1
simultaneously, see section 7)
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Figure 4. Proper attachment of
tether, with loop for strain relief.

Figure 5. Attach stability weight
to the bottom eye with locking
carabiner.

Figure 6. To deploy, lower the stability weight into the water while holding the WaLRUS on deck. Then lower the WaLRUS.
4.2.4 Retrieval
• Use the tether to pull WaLRUS back to the ship.
• Haul aboard with the tether, and using the top protective ring (see Figure 1) as a
hand-hold.

4.3 Profiling
4.3.1 Preparation
• Prepare as for surface deployment, with the addition of securing a profiling
weight to the bottom of the stability weight (Figure 7). The rope for the profiling
weight must be long enough that the profiling weight can rest on deck while the
WaLRUS and stability weight are in the water, and at the desired distance from
the ship. Adjust it if necessary.
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Figure 7. Weights and ropes for profiling. Upper weight with white ropes is stability
weight. Lower with green rope is profiling weight. Adjust rope lengths by adjusting the
loops, as shown in Figure 8.

4.3.2 Deployment
• Follow the procedure for surface deployment, but keep the profiling weight on
deck.
• When WaLRUS is in the desired position and you are ready to begin the profile,
lower the profiling weight into the water, and start data collection.
• When WaLRUS reaches desired depth, stop data collection.
• Use tether to pull WaLRUS back to the surface

4.4 Weight and Rigging Details
4.4.1 Weights
The weights supplied with the WaLRUS are made up of lead discs of the following
sizes:
• 7 cm diameter, 0.53 kg
• 11 cm diameter, 1.45 kg
• 15 cm diameter, 2.6 kg
Typically, the stability weight is made up of three 15-cm discs and two 7-cm
discs, for a total weight of 8.9 kg. This is generally appropriate for deploying the WaLRUS in either fresh water or sea water, although it may need to be adjusted depending on
11

deployment conditions and on the exact configuration in which you deploy your WaLRUS. When deployed with a correct stability weight, the WaLRUS should float with its
electrical connector slightly above the surface of the water, as shown in Figure 3.
A typical profiling weight is 5.8 kg, but you may wish to adjust this to tailor the
rate of descent based on conditions and your preferences.

4.4.2 Adjusting Rope Lengths
• The ropes supplied with the WaLRUS can be used at their full length by simply
attaching the spring clips to the desired weights. Their lengths can also be reduced in two different ways.
• First, the rope can be formed into a large loop, as shown in Figure 7, by attaching
the spring clip to a small loop tied as shown in Figure 8.
• Second, you can change the rope length by adjusting the rope clamps used to form
the loops in the ends of the ropes (see Figure 9).

Figure 8. Tying a loop for shortening a rope.
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Figure 9. Assembling a rope clamp. First place the rope in the half of the clamp with
unthreaded screw holes. Hold the screws in place while place the other half (not shown)
on top. Then tighten the screws.
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5 POWER AND COMMUNICATION INTERFACE
5.1 Connections and Power Supply
WaLRUS II can be powered from three sources: external 10V to 15V supply, internal battery, and external 18 to 24V battery charger
Any combination of these sources may be safely connected simultaneously. Power will be drawn from the source with the highest voltage. Nominal power draw at 12V
input is 50 mA plus 70 mA per channel during sampling, and 1 mA during low-power
sleep. Note that if the battery charger is connected as the only power source, operating
the WaLRUS will reduce the charging current to the battery and increase the needed
charging time.
The WaLRUS communicates via RS-232 through a standard COM port or
through a suitable USB adapter. Power and data lines are brought out on a SubConn
MCBH8M connector (mate: MCIL8F), with pins assigned as shown below.

PIN

FUNCTION

1

Supply voltage (10 to 15 VDC)

2

Common

3

RS232 Instrument Receive

4

RS232 Instrument Transmit

5

Battery charging input (18 to 24 VDC)

6

Reserved

7

Reserved

8

Short to Common to Disable Battery

The supplied power/data interface cable splits into a DB9 for RS-232 communication, a “barrel” connector for the battery charger, and a pigtail for an external DC supply.

14

5.2 Internal Batteries
5.2.1 Battery Capacity
The capacity of the battery depends on the temperature at which it is charged,
stored, and discharged. Charging and storage at temperatures of 20 C or less improve
capacity. On the other hand, low temperatures during discharge lower the realized capacity. Peak capacity for a battery charged and discharged at room temperature is about 20
hours of continuous operation with a 3-channel WaLRUS.
In response to the SLEEP software command, the WaLRUS will enter a lowpower sleep state during which its current drain is reduced to less than 1 mA. In this state
fully charged batteries will last about 2 months. Hourly sampling schemes can typically
last about 1 month.
Capacity decreases slowly as the battery ages. The capacity loss depends greatly
on charging conditions, but is typically less than 10% after 200 charge/discharge cycles,
and 20% after 500 cycles.
5.2.2 Battery Voltage and State of Charge
To read current value of the battery voltage whenever communication is established with the sensor, enter the BATT command. This will display the current voltage
and the battery charging current. The battery voltage gives a rough indication of how
much charge remains. When the battery voltage falls below 10 V, indicating it is virtually
completely discharged, the WaLRUS should not be used in battery-mode operation.
WaLRUS will go into its low-power sleep mode whenever the voltage falls below this
threshold.
5.2.3 Charging
WaLRUSs with batteries installed include constant-current chargers that recharge
the battery in a maximum of 15 hours. The actual charging time required after a partial
discharge is about the same as the time the WaLRUS was being operated from the batteries. Charging continues at the same rate as long as the charger is plugged in.
If the WaLRUS is operating with the battery charger plugged in, note that the current going to the batteries will be reduced and the charging time will increase. For fastest
charging, either put WaLRUS to sleep, or provide an external power supply whose voltage is higher than the battery voltage. A 13.8V power supply is recommended for this
situation.
While the battery tolerates indefinite periods of charging, repeated, prolonged
charges can eventually degrade battery capacity. For best battery life we recommend that
15

you charge, on average, not more than 3 times the time that the sensor is operated from
the battery (not including “sleep” time).
5.2.4 Battery-disconnect Plug
The battery can be electronically disconnected from
the WaLRUS circuitry by shorting pins 2 and 8 of the
bulkhead connector together. HOBI Labs supplies a special dummy plug, distinguished from a standard dummy by
a pink or red handle, for disconnecting the battery (Figure
10). Apply this plug when shipping or storing the instrument for long periods, to protect the batteries
against excessive discharge. The battery-disconnect plug
can also be used to reboot the instrument in case of a software fault.

Figure 10. Batterydisconnect plug

Note that like the hard disk in a computer, WaLRUS’s flash memory can be corrupted if power is removed while it is updating its directory. Therefore, do not disable
the battery while WaLRUS is storing data or performing file operations.
Disabling the battery will cause WaLRUS’s real-time clock to reset, and will also
reset any parameters that were changed without being saved to flash by the
SAVEPARAMS command.

5.3 Communication interface
WaLRUS communicates through a standard RS-232 serial connection to any
computer serial port, or through a USB-serial adapter. The serial protocol settings are 8
data bits, no parity, 1 stop bit, and no flow control. Only the transmit, receive and ground
lines are connected between WaLRUS and the computer.
Any common terminal emulator program can be used to communicate with the
WaLRUS, but the software provided by HOBI Labs has many features tailored specifically for the WaLRUS.
5.3.1 Baud Rate
WaLRUS can operate at any baud rate from 2400 to 115,200. In order to transfer
spectra rapidly, it is desirable to set the baud rate as high as possible. But the actual rate
is limited by the cable connection to the host computer, and in some cases by the serial
interface hardware on the computer. WaLRUS is typically set to a rate of 57,600 at the
factory, which is safe for most cables up to 100 meters and often longer.
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After it is reset (by disabling the internal battery, or sending the RESET command), the WaLRUS temporarily starts up at 9600 baud, and sends a message indicating
what baud rate it will change to. If you are having trouble communicating and suspect a
baud rate problem, set your software to 9600 baud, reset the WaLRUS, and send the control-X character during this startup sequence. That will cancel the baud rate change and
hold the baud rate at 9600 until you explicitly change it.
The BAUD command changes the current baud rate. To permanently change the
rate, end the command with the word “store”, for example:
BAUD 115200 store <return>
will cause the WaLRUS to change to 115,200 baud after the next reset.
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6 TILT - ROLL - HEADING SENSOR
WaLRUS II includes a 3-axis magnetic sensor to measure its attitude (tilt and roll) and
compass heading. Its orientation is defined as follows:
•

Positive tilt is inclination toward the tether attachment eye;

•

Positive roll is inclination toward the right, when the tether attachment eye is facing the observer;

•

Zero compass heading is when the tether attachment is facing the magnetic south
pole.

6.1 Real-time display
To view a continuous display of the orientation in real time, open a terminal window in RadSoft by double-clicking on the WaLRUS icon on the RadSoft Desktop. Type
“tilt cont” into the terminal window. Data will then be displayed in the format time,
heading, tilt, roll. Time is measured in seconds since midnight, January 1, 1970. Heading is in degrees, ranging from 0 to 359.9, and tilt and roll are in degrees with a range of 60 to +60.
To test the sensor, stand the WaLRUS upright, and rotate it while observing the
orientation data. The heading values should change with the rotation, while the tilt and
roll values change only slightly. Then tip the WaLRUS in different directions while observing corresponding changes in the tilt and roll values.
To stop continuous tilt display, send the command “tilt”.

6.2 Stored Data
Each time it stores spectral data in a file in its flash memory, the WaLRUS also
stores a set of orientation data sampled at the beginning and end of the spectrometers’
integration time. For example, if you specify that spectral data will be stored with a base
file name of “TEST” (see the Quick Start section), a file named “TEST.TLT” will be
stored that contains the orientation data for each spectrum. Each line in the .TLT file will
be in the form:
time1, heading1, tilt1, roll1, time2, heading2, tilt2, roll2
The first four data are stored at the beginning of the corresponding spectrum, and the second four at the end.
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7 OPERATION WITH HYDRORAD-E1
The HydroRad-E1 is a single-channel radiometer especially suited as a companion to the
WaLRUS, for collecting irradiance data on the deck of the ship while a WaLRUS is deployed. First, the HydroRad-E1 light collector can be shaded from direct sunlight to
measure the irradiance of the sky, as described in section 7.3. Second, the HydroRad-E1
provides surface irradiance measurements when the Ed collector on the WaLRUS II is
submerged during profiling.

7.1 To Add a HydroRad-E1 to RadSoft Setup
•

•
•
•

•

Install a second RS232-USB interface on your computer, as described in the
Quick Start section. You may need to reboot your computer in order for it to recognize the new interface.
Start RadSoft and connect to the WaLRUS as in the Quick Start section.
Connect the HR-E1 through its PDI cable, similarly to the WaLRUS connection,
and connect its battery charger.
In the RadSoft Desktop window, select New->New Device from the File menu. It
will display the Connect To Instrument dialog box. Check the Load Calibration
From Instrument option, and Click the Find port & baud rate button.

RadSoft will detect the HydroRad-E1 and create a new icon for it in the RadSoft
desktop window:
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7.2 To Operate WaLRUS and HydroRad-E1 Simultaneously
After you set up both instruments in RadSoft, double-click on their icons to open
terminal windows. The terminal windows allow you to send commands directly to the
instruments.
Click on the WaLRUS terminal window to bring it to the front, then press the enter key to see the WaLRUS> prompt. Then type
START ACQUIRE
(followed by the enter key). To stop acquisition, press control-C. If an integration is in
progress, you may need to press control-C more than once.
Use the same process to control the HydroRad-E1, but it will show a HydroRad>
prompt in its terminal window.

7.3 Measuring Sky Irradiance Data
For remote-sensing applications, collect sky irradiance data by using a small black
disk to block direct sun from falling on the irradiance collector, as shown in Figure 11.
For best results, hold the shadowing disk such that the white diffuser of the Ed collector
is in the center of the shadow. Hold the shadowing disk at least 15 to 20 cm away, so that
the light collector will still be exposed to the entire sky, but not to the direct sun. Ship
motion will prevent you from holding the disk perfectly still, but motion will not affect
the data as long as the shadow completely covers the white diffuser throughout the measurement.

Figure 11. Shading Ed collector to measure sky irradiance
20

8 MAINTENANCE, SERVICE AND SUPPORT
8.1 Calibration
WaLRUS is a sophisticated scientific instrument that requires regular calibrations
in order to deliver its full performance. We recommend radiometric calibration, using the
specialized equipment and procedures developed at HOBI Labs, every six months or 200
hours of operation, whichever is sooner.

8.2 Maintenance
•

Observe all the precautions listed in section 1.

•

Wash salt water away from the instrument after every use, and dry the WaLRUS
before storage.

•

Regularly inspect the light collectors for
damage. Note that the copper parts on the
radiance collectors do normally develop a
green oxide layer.

•

Apply the battery-disconnect plug during
storage and shipment, and fully charge the
batteries at least once every two months.

•

Check the condition of the zinc anodes on the bottom end cap (see Figure 12). If
they show major erosion, contact HOBI Labs about replacing them.

Figure 12. Two round zinc anodes protect the other metal
parts from corrosion.

8.3 Service and Support
For help and advice regarding the operation of your WaLRUS, contact HOBI
Labs at support@hobilabs.com, or through our web site, www.hobilabs.com, where you
can also download manuals, software and other technical information.

8.4 Equipment Return
To return your equipment to HOBI Labs for any reason, first contact us for a returned material authorization (RMA) number, at support@hobilabs.com. The RMA is
very important for tracking your equipment. Please provide us with the instrument serial
number, the address to which it should be returned after service, and any special requests.
Upon issuing the RMA we will send you shipping instructions.
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After we receive the equipment, we will inspect and test it, and send a description
and cost estimate for any service required. We will not proceed with service until we receive your authorization for the cost.
Always ship your WaLRUS II in its original case, which is designed to protect it
against rough handling.
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9 APPENDIX: DIRECT COMMANDS
This section describes in detail the commands used to communicate with and control the WaLRUS operating firmware. You do not need to know the details of these
commands if you use RadSoft to communicate with your WaLRUS, but may need them
for special applications, or in order to communicate directly through a text terminal or
other software. Within RadSoft, you can send and receive commands in a terminal window.

9.1 Command Conventions
For clarity in this document commands are shown in upper case, but they are not
case-sensitive.
Some commands accept arguments, which are separated from the base command,
and from each other, by commas or spaces. Arguments may be individually omitted, in
which case they will have no effect. For example, if a command accepts three arguments,
in the form COMMAND,arg1,arg2,arg3 (or COMMAND arg1 arg2 arg3), you may adjust
only arg3 by entering COMMAND,,,arg3.
Most commands reply with the settings of relevant parameters, or other status information.
9.1.1 Reserved Words
The words “on”, “open”, or “yes” are all defined as equal to 1 in command arguments that expect logical values, and may be used in place of the value 1. In place of the
value zero in command arguments, the words “off”, “close”, or “no” may be used. These
words are not case sensitive.
9.1.2 WaLRUS Channel Numbering
Commands that refer to channels will accept either a channel number or letter as
an argument. Thus, the first channel can be referred to as either “1”, “a”, or “A”.

9.2 Configuration Commands
9.2.1 AUTOPARAMS SatValue MinPeak MaxSatPixels MinPeakPixels MaxAttempts PreFilter
Shows and sets parameters governing the automatic setting of integration time (used by
AUTO, ACQUIRE, LOG, and LOGAUTO).
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The first four parameters define what is considered an acceptable dynamic range
for the pixel values in a spectrum. SatValue defines the value at which a pixel is considered saturated. MinPeak is the minimum value at which a pixel is considered fully exposed. The range for both of these values is 2000 to 32760.
Please note that higher SatValue and MinPeak settings will result in more fully
saturated, potentially more accurate readings when used with the “LogAuto,” “Log Auto” or “Acquire Auto” command sequences. However, when using the Log or Acquire
commands in the default speed-auto mode, higher settings will lead to more over-exposed
samples, and less usable data. In fact, if light levels are changing rapidly, lower SatValue
and MinPeak settings will result in fewer over-exposed measurements, and more usable
data in speed-auto mode.
The algorithm will attempt to find an integration time that results in a spectrum
that has at least MinPeakPixels whose values are between SatValue and MinPeak. It will
allow up to MaxSatPixels that exceed SatValue. MinPeakPixels has the lowest priority of
the criteria. A spectrum may be considered well exposed even if it does not meet
MinPeakPixels.
MaxAttempts is the maximum number of trial integrations allowed. The algorithm
will terminate after this many integrations if it does not achieve a spectrum that meets the
dynamic range criteria. Within LOGAUTO, the last integration will be logged whether
or not it terminated normally.
PreFilter sets the width of a filter that excludes occasional "hot" pixels from consideration. Under most circumstances this should be set to 3.
9.2.2 BAUD newrate [/Q] [store]
Change to a new baud rate. Without the /Q flag, BAUD replies:
Changing to XXXX BAUD.
Hit <return> when ready…
and waits until it receives another character (not necessarily <return>). With the /Q flag
(which stands for “quiet”), the baud rate will immediately change without any further input. There must be a space between the newrate parameter and the /Q flag, or the /Q will
be ignored.
Standard baud rates from 2400 to 230,400 baud are supported. Note that most PC
serial ports do not support 230,400 baud, and some may have trouble with even lower
rates. Also note that high baud rates may not work over long cables. If you plan to use
high baud rates and long cables in the field, test your system first in the lab!
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The baud rate you set remains in effect until changed by another BAUD command, you exit the WaLRUS operating software, or the WaLRUS is reset by removal of
power or the RESET command. To make the change in baud rate permanent, include the
key word “store” in the baud command.
9.2.3 DEPTHCAL Offset ScaleFactor
For DEPTHCAL sets the coefficients used to calculate calibrated depth readings
from the WaLRUS pressure sensor (if one is installed). Offset is the raw reading at atmospheric pressure. ScaleFactor is the coefficient to convert digital counts to equivalent
meters of depth in water. Values entered with DEPTHCAL take effect immediately, and
are saved in the file DEPTH.CAL so they will remain in effect until changed with another
DEPTHCAL command.
9.2.4 DATE mm/dd/yy hh:mm:ss
Identical to the TIME command. Sets the date and/or time of the real-time clock.
The command will accept partial dates (for example 3/1 sets the month to 3 and the day
to 1 without affecting the year) and times (for example 13:24 sets the hour and minute
without affecting the seconds). Years may be entered with 2 or 4 digits.
9.2.5 ECHO state or ECHO string
State specifies whether characters sent to WaLRUS’s serial port are automatically echoed. If state is “on” (1) then echo is turned on, if state is “off” (zero) then echo is
turned off. The default is on. With echo off, characters you type will not appear in your
terminal software.
If a string follows the echo command, the string will be echoed to the command
line. Be careful, because if the first word of the string is one of the WaLRUS reserved
words: “on”, “open”, “yes”, “off”, “close”, “no”, the value of the reserved word will be
used as if you were specifying a State, and the rest of the string will be ignored.
9.2.6 ID
Displays the factory-set model, serial number, and configuration information
about the WaLRUS.
9.2.7 IMPORTCAL Filename
Given a file containing properly formatted calibration data for one or more channels, translates the file into a binary format for future rapid loading. The resulting binary
files are named A.CAL for channel 1, B.CAL, etc.
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If the DAISYCHAIN command is used, IMPORTCAL does NOT have to be repeated.
9.2.8 INTPARAMS MinTime MaxTime WarmupTime AutoPowerDown
Channels
Shows and sets parameters governing integration. MinTime is the minimum integration time, in milliseconds, used in auto-integration commands such as AUTO,
LOGAUTO, and START. This is typically set to the electronic limit of 20 ms. MaxTime
is the maximum integration time, in milliseconds, used in auto-integration commands
such as AUTO, LOGAUTO, and START. Practical values of MaxTime range from 2000
to 30000 milliseconds, although it can be set higher.
WarmupTime is the number of seconds WaLRUS will wait before collecting spectra after power is first applied to the spectrometers.
AutoPowerDown can be either zero, or a number greater than zero. If it is nonzero, then power to the spectrometers will be turned off if they are idle for more than 2
seconds plus WarmupTime.
Channels is a string of digits or letters specifying from which channels data will
be collected. For example, 13 or AC indicates that channels 1 and 3 are enabled. Note
that WaLRUSs may be equipped with different numbers of channels. Normally all installed channels should be enabled.
9.2.9 LAMBDA Channel Pixel
Given a channel and pixel (ranging from 0 to 2047), displays the wavelength (in
nm) corresponding to the pixel. Channel may be specified with a letter, a number, and
asterisk "*" for all channels. If no channel is specified, the current CHAN setting is used.
9.2.10 LOADPARAMS FileName
LOADPARAMS restores parameters saved in a file by SAVEPARAMS. If no
FileName is specified, it loads HYDRORAD.INI.
9.2.11 LOGPARAMS SampleInterval SampleDuration Processing OutputFormat OutputDestination
SampleInterval and SampleDuration, both in seconds, are used for continuous periodic collection as initiated by the START command or trigger switch. They are not relevant to collection scheduled by a command file, unless that file contains a START
command.
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IMPORTANT: The Processing parameter can interact with other parameters to
affect the quality of your data. We recommend a processing level of 0 for most applications.
The Processing parameter controls which calibration steps are applied to data before they are filtered and saved:
0 - raw, unprocessed “counts” are returned
1 - pixel adjustments are performed
2 - dark-current is calculated and subtracted from the counts
3 – counts are divided by the integration time
4 - engineering units are returned (full calibration)
OutputFormat controls whether spectra generated by the logging commands (LOG,
LOGFIXED, LOGRANGE and LOGAUTO) are in ASCII or binary format:
-2: spectra saved in binary with CRC checksum and host reply (.BIN extension on
files). If the output is to the console, the data is followed by a "?". Within 2 seconds, the host must respond with an acknowledgment of good data "Y", or an indicator of bad data "X". If bad data is indicated, or no response is received in 2
seconds, then the data is re-sent, up to 10 times per channel.
-1: spectra saved in binary with CRC checksum (.BIN extension on files)
0: spectra saved in binary (.BIN extension on files)
1: spectra saved in text (.ASC extension on files
2: for backwards compatibility, sets OutputFormat to 0 and sets OutputDestination to 2.)
3: for backwards compatibility, sets OutputFormat to 1 and sets OutputDestination to 2.)
OutputDestination selects where data are output:
0: multiple files (Channel letter appended to file name)
1: single file
2: host console
3: host console + multiple files
4: host console + single files
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9.2.12 PARAMS
Displays all the settable parameters. Similar to typing LOGPARAMS,
FILTPARAMS, AUTOPARAMS and INTPARAMS in succession, except that
PARAMS can not change any parameter values. This is handy if you forget which parameters are available, or which command to use for a particular setting. See also
SAVEPARAMS, LOADPARAMS.
9.2.13 PIXEL Channel Wavelength
Given a channel and wavelength, displays the pixel most closely corresponding to
the wavelength. Channel may be specified with a letter, a number, or an asterisk "*" to
specify all channels. If no channel is specified, the current CHAN setting is used.
9.2.14 SAVEPARAMS Filename
SAVEPARAMS stores all the parameters set with LOGPARMS, INTPARAMS,
AUTOPARAMS and FILTPARAMS in a file with the given Filename. If no Filename is
specified, they will be stored in HYDRORAD.INI, which is automatically loaded whenever
WaLRUS starts up.
9.2.15 SET VariableName Value
Sets the value of environment variable VariableName to Value, which can be a
string or numeric expression. Use %VariableName% to insert the value into other expressions.
9.2.16 SHOWCAL Channel FirstPixel LastPixel
Displays, in ASCII, the currently loaded calibration data for a given channel, from
the FirstPixel to the LastPixel. Header information displayed includes WaLRUS Serial
Number, Channel name, Units, and Scale. For each pixel between FirstPixel and
LastPixel, the constants displayed include “F,” which determines the dark current calibration function to use, “C,” which is the floating point constant used in the dark current calibration, and “Epsilon,” which the count rate is divided by to obtain engineering units.
Channel may be entered as a letter, a number, or an asterisk "*" to indicate all channels.
9.2.17 TIME mm/dd/yy hh:mm:ss
Identical to the DATE command. Sets the date and/or time of the real-time clock.
The command will accept partial dates (for example 3/1 sets the month to 3 and the day
to 1 without affecting the year) and times (for example 13:24 sets the hour and minute
without affecting the seconds). Years may be entered with 2 or 4 digits.
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9.2.18 TXDELAY Delay
Sets the minimum time (in milliseconds) by which WaLRUS delays its responses
to commands, in case the system with which it is communicating requires such a delay.
9.2.19 VER
Displays the version number and date of the WaLRUS firmware.
9.2.20 ZERODEPTH
ZERODEPTH measures the current raw reading of the pressure transducer (if installed), then records this as the Offset used for calculations of calibrated depth (which
may also be set with DEPTHCAL). If executed while the WaLRUS is at atmospheric
pressure, ZERODEPTH compensates for offset errors due to the effects on the transducer
of temperature and barometric pressure.

9.3 General Operations
9.3.1 <enter>
Pressing the enter key on a blank line will repeat the last command.
9.3.2 \command
Any command preceded by a backslash will be passed to the operation system for execution. This is not needed under normal circumstances.
WARNING: Although you can use this mechanism to launch another program, or
run a batch file, from within WaLRUS, this is not advisable. It leads to a disorderly exit
from WaLRUS, and the computer may not return to WaLRUS upon completion of the
other program.
9.3.3 BATT
Displays the current supply voltage and charge current (if battery is being
charged). This is typically the voltage of the internal battery, but may also be supplied by
an external source. If the external source’s voltage is higher than the battery voltage, its
voltage will be reported. The voltage reported will be somewhat lower than actual voltage of the source, since it is measured after passing through a protective diode.
9.3.4 DEPTH
If your WaLRUS is equipped with a depth sensor, this displays the current calibrated depth in meters.
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9.3.5 PAUSE Seconds
Used primarily in command files, PAUSE illuminates the red indicator, waits for
the given number of seconds (5 if Seconds is not specified), then switches the indicator to
green.
9.3.6 PICODOS
Exits the WaLRUS program and sends control to the operating system prompt.
Note that if an AUTOEXEC.BAT file is present on the flash disk, it will be executed. If the
current baud rate is other than 9600, PicoDOS will set it to 9600, unless otherwise instructed in an AUTOEXEC.BAT file.
9.3.7 POWER State
Turns on (state = 1) or off (state = 0) power to the spectrometers. POWER may
also be used without an argument to display the current status. Any command that initiates an integration will automatically turn on the power first if necessary, and executing
SLEEP will turn it off, so this is rarely needed in normal use.
9.3.8 PRESSURE
Displays the current raw reading of the pressure transducer (if installed). See also
DEPTH.
9.3.9 RESET
Reinitializes the WaLRUS program, which executes any BAUD command in
AUTOEXEC.BAT if it exists, loads the parameters in HYDRORAD.INI if it exists, executes the
commands in HYDRORAD.CMD if it exists, and loads any calibration files that exist.
9.3.10 SLEEP Seconds
Turns off the spectrometers and puts the system in low-power sleep for the given
number of seconds. If Seconds is not specified, sleeps indefinitely. Sleep can always be
interrupted by receipt of characters on the serial port, or by the sleep/wake switch.
9.3.11 TEMP
Displays the internal temperature of the spectrometers in degrees C.
9.3.12 TIMES TimeA TimeB TimeC TimeD TimeE TimeF TimeG …
Displays the most recently used integration time for each channel. If times are
specified, they will be stored as if they were the most recently used integration time.
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9.3.13 TOM8
Exits the WaLRUS program, sets the baud rate to 9600, and enters the TOM8
monitor program. Unlike exiting to PicoDOS with the PicoDOS or QUIT command, this
allows exiting the WaLRUS program without executing an AUTOEXEC.BAT file, if one is
on the flash disk. Therefore TOM8 is not affected by any BAUD instructions.

9.4 Data Collection
9.4.1 ACQUIRE [AUTO/FIXED] Count [SEC] Average BaseName Process
Format Dest Channels FirstPix LastPix PixInc FilterType FilterSize
Collects data from all channels, sending the data to the host console by default.
This command is very similar to the LOG command, but uses different default settings.
The first (optional) parameter sets the exposure time mode. "AUTO" iteratively
tries to find the optimum exposure time for each channel (within the limits set with
INTPARAMS), which may mean that for each data sample, the instrument may take several measurements. "FIXED" re-uses the last integration time, or the times specified in
the "TIMES" command. "SPEED" (default) uses auto-integration for the first data collection, and then makes only one measurement per subsequent data collection. Occasionally,
data samples will be over or underexposed, but overall, the data sampling rate will be
maximized.
The second parameter, Count, specifies the number of samples to take. If the
word "SECONDS" (or an abbreviation as short as "sec") appears as the next argument,
then Count is to be interpreted as a duration in seconds during which data should be collected.
If Average is nonzero, only one averaged spectrum will be produced for each active channel. Otherwise each spectrum measured will be sent to the host and/or saved.
If BaseName is specified, and Dest setting indicates data are to be saved in multiple files, the file name for each channel will be formed from the BaseName, followed by
a letter indicating the channel (A = 1, B = 2, etc.), followed by an extension indicating the
data format. If the Dest setting indicates data are to be saved in a single file, the letter indicating the channel will be omitted. If BaseName is not specified, the base name will
be the date, in the form MMDDYY.
The Process parameter controls which calibration steps are applied to data before
they are filtered and saved:
0 - raw, unprocessed (default for Acquire command)
1 - pixel adjustments
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2 - dark-current compensation
3 - normalized by integration time
4 - engineering unit scaling (full calibration)
The Format parameter selects the format in which data are output:
-2: spectra saved in binary with CRC checksum and host reply (.BIN extension on
files). If the output is to the console, the data is followed by a "?". Within 2 seconds, the
host must respond with an acknowledgment of good data "Y", or an indicator of bad data
"X". If bad data is indicated, or no response is received in 2 seconds, then the data is resent, up to 10 times per channel. (default for Acquire command)
-1: spectra saved in binary with CRC checksum (.BIN extension on files)
0: spectra saved in binary (.BIN extension on files)
1: spectra saved in text (.ASC extension on files)
The Dest parameter selects where data are output:
0: multiple files (Channel letter appended to file name)
1: single file
2: host console (default for Acquire command)
3: host console + multiple files
4: host console + single files
Channels is a string of digits indicating with spectrometer channels are enabled.
For example, 124 indicates that channels 1, 2 and 4 are enabled. By default, all channels
are enabled for the Acquire command.
FirstPix, LastPix, and PixInc are used to sub-sample the measured data. They
determine which pixels will be included in the output spectrum. If PixInc is a positive
number, then FirstPix, LastPix, and PixIncrement will correspond to physical pixels. If
PixInc is a negative number, and a calibration has been imported into the WaLRUS (see
ImportCal) then FirstPix and LastPix, and |PixInc| will be 10ths of nanometers. For example, if 400, 2000, and 2 are specified, then the output will consist of pixels 400, 402,
404, 406, ... 2000. If 3500,8500, and -25 are specified, then output will consist of pixels
corresponding to wavelengths at 350nm, 352.5nm, 355nm 357.5nm, ... 850nm. By default, FirstPix = 1, LastPix 2047, PixInc = 1, corresponding to every pixel.
FilterType can be 0, 1, or 2. A value of 0 (zero) or "off" specifies no filtering. A
value of 1 specifies boxcar averaging, in which case each pixel in the output spectrum
will be the result of an equally-weighted average of the number of pixels or wavelength
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range specified by FilterSize (rounded up to an odd integer if necessary). A value of 2
specifies Gaussian averaging, where each pixel in the output spectrum will be the result
of an normal distribution-weighted average, with a full width at half max (FWHM) equal
to the number of pixels or wavelength range specified by FilterSize. By default, FilterType is 0 and FilterSize is 1(no filtering).
If FilterSize is a positive integer, then it will correspond to that fixed number of
pixels. By default, FilterSize is 0 (no filtering).
9.4.2 AUTO Channel IntTime
Collects a spectrum to memory from the given channel, automatically seeking the
optimum integration time. If IntTime is specified, it will try that time first. If not, it will
start with the integration time that was last used for that channel (regardless of which
command triggered the previous integration). If no Channel is specified, it will collect
from the last used channel. Channel may be entered as a letter, a number, or an asterisk
"*" to indicate all channels.
9.4.3 CHAN Channel
If no Channel is specified, displays the most recently used spectrometer channel.
If a Channel is specified, sets the current channel to that value. Channel may be entered
as a letter, a number, or an asterisk "*" to indicate all channels. This channel setting will
be used as the default channel for subsequent AUTO or INT commands.
9.4.4 FILT FirstPixel LastPixel PixelIncrement Channel
Displays the most recent spectrum collected with INT or AUTO, after applying
the current filter (see FILTPARAMS). If Channel is specified (or an asterisk "*" for all
channels), the most recent spectrum from that channel is shown. Press Control-C, or send
an ASCII code 03 to break out of the listing.
9.4.5 GRAPH FirstPixel LastPixel VerticalScale Channel
Displays a crude graph of the most recent raw spectrum (whose numerical values
can be viewed with RAW). The X-axis represents pixels numbers over the range specified by FirstPixel and LastPixel. The width of the graph is fixed at 80 characters. If no
FirstPixel and/or LastPixel are specified, the corresponding values set by the
FILTPARAMS command will be used.
The Y-axis represents pixel amplitudes in digital counts. VerticalScale specifies
the graph’s height in lines. The Y-axis always covers the full range of pixel values from 0
to 32767. Therefore the default VerticalScale value of 32 is equivalent to 1000 counts
per line.
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If Channel is specified (or an asterisk "*" for all channels), the most recent spectrum from that channel is shown.
Note that because of the low resolution of the display, many details of the spectrum may not be apparent.
9.4.6 INT Channel Time
Collects a spectrum from the specified Channel, with the specified integration
Time (in ms). Channel may be entered as a letter, a number, or an asterisk "*" to indicate
all channels. If no Channel is specified, uses the most recently specified channel (that
displayed by CHAN). If no Time is specified, uses the time most recently used by the
current or specified channel.
The Time parameter may also take the form of *Time, /Time, +Time, or –Time. In
this case, the operator specified and the new Time argument will be applied to the previous integration time for the channel. So if the previous integration time for channel A
was 35 ms, and the command INT, A , *2 was used, channel A would be integrated for
70 milliseconds. This may be useful for intentionally overexposing the spectrometer after a AUTO command, to get better resolution in the UV in UR ranges.
9.4.7 LOG [AUTO/FIXED] Count [SEC] Average BaseName Process Format
Dest Channels FirstPix LastPix PixInc FilterType FilterSize
Collects data from all channels, storing the data as specified in the Params settings
by default. This command is very similar to the ACQUIRE command, but uses different
default settings.
The first (optional) parameter sets the exposure time mode. "AUTO" iteratively
tries to find the optimum exposure time for each channel (within the limits set with
INTPARAMS), which may mean that for each data sample, the instrument may take several measurements. "FIXED" re-uses the last integration time, or the times specified in
the "TIMES" command. "SPEED" (default) uses auto-integration for the first data collection, and then makes only one measurement per subsequent data collection. Occasionally, data samples will be over or underexposed, but overall, the data sampling rate will be
maximized.
The second parameter, Count, specifies the number of samples to take. If the
word "SECONDS" (or an abbreviation as short as "sec") appears as the next argument,
then "Count" is to be interpreted as a duration in seconds during which data should be
collected.
If Average is nonzero, only one averaged spectrum will be produced for each active channel. Otherwise each spectrum measured will be sent to the host and/or saved.
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If BaseName is specified, and the Dest setting indicates data are to be saved in
multiple files, the file name for each channel will be formed from the BaseName, followed by a letter indicating the channel (A = 1, B = 2, etc.), followed by an extension indicating the data format. If the Dest setting indicates data are to be saved in a single file,
the letter indicating the channel will be omitted. If BaseName is not specified, the base
name will be the date, in the form MMDDYY.
The Process parameter controls which calibration steps are applied to data before
they are filtered and saved (the default setting is to use the LogParams "Processing" setting):
0 - raw, unprocessed
1 - pixel adjustments
2 - dark-current compensation
3 - normalized by integration time
4 - engineering unit scaling (full calibration)
The Format parameter selects the format in which data are output (the default setting is to use the LogParams "OutputFormat" setting):
-2: spectra saved in binary with CRC checksum and host reply (.BIN extension
on files). If the output is to the console, the data is followed by a "?". Within 2
seconds, the host must respond with an acknowledgment of good data "Y", or an
indicator of bad data "X". If bad data is indicated, or no response is received in 2
seconds, then the data is re-sent, up to 10 times per channel.
-1: spectra saved in binary with CRC checksum (.BIN extension on files)
0: spectra saved in binary (.BIN extension on files)
1: spectra saved in text (.ASC extension on files)
The Dest parameter selects where data are output (the default setting is to use the
LogParams "OutputDestination" setting):
0: multiple files (Channel letter appended to file name)
1: single file
2: host console (default for Acquire command)
3: host console + multiple files
4: host console + single files

35

Channels is a string of digits indicating with spectrometer channels are enabled.
For example, 124 indicates that channels 1, 2 and 4 are enabled. By default, the channels
specified in the IntParams "Channels" setting are used.
FirstPix, LastPix, and PixInc are used to sub-sample the measured data. They
determine which pixels will be included in the output spectrum. If PixInc is a positive
number, then FirstPix, LastPix, and PixIncrement will correspond to physical pixels. If
PixInc is a negative number, and a calibration has been imported into the WaLRUS (see
ImportCal) then FirstPix and LastPix, and |PixInc| will be 10ths of nanometers. For example, if 400, 2000, and 2 are specified, then the output will consist of pixels 400, 402,
404, 406, ... 2000. If 3500,8500, and -25 are specified, then output will consist of pixels
corresponding to wavelengths at 350nm, 352.5nm, 355nm 357.5nm, ... 850nm. By default, the settings specified in the FiltParams command are used.
FilterType can be 0, 1, or 2. A value of 0 (zero) or "off" specifies no filtering. A
value of 1 specifies boxcar averaging, in which case each pixel in the output spectrum
will be the result of an equally-weighted average of the number of pixels or wavelength
range specified by FilterSize (rounded up to an odd integer if necessary). A value of 2
specifies Gaussian averaging, where each pixel in the output spectrum will be the result
of an normal distribution-weighted average, with a full width at half max (FWHM) equal
to the number of pixels or wavelength range specified by FilterSize. By default, the "FilterSpec" setting specified in the FiltParams command is used.
If FilterSize is a positive integer, then it will correspond to that fixed number of
pixels. If FilterSize is a negative integer, then the filter width will be that many 10ths of
nm wide. So, a FilterSize of 5 specifies a 5 pixel-wide filter. A filter size of -15 specifies
a 1.5 nm wide filter. By default, the "FilterSize" setting specified in the FiltParams command is used.
9.4.8 LOGRANGE MinTime MaxTime TimeStep Mode Averages BaseName
Process
LOGRANGE repeatedly executes LOGFIXED, over a range of integration times.
The first integration on each channel will be for MinTime milliseconds. If Mode is 1, the
second integration will be at MinTime * TimeStep. If Mode is 0 (zero), the second will
be at MinTime + TimeStep. Integrations continue with increasing length until the integration time is equal to MaxTime. If the last calculated time is greater than MaxTime, a final integration will be performed for MaxTime. For example, LOGRANGE,20,1000,3,1
will integrate each channel at 20, 60, 180, 540 and 1000 milliseconds.
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If MinTime, MaxTime, or TimeStep is omitted, the corresponding value set by
INTPARAMS will be used. Averages and BaseName have the same meaning as with
LOGFIXED.
If a value is specified for Process, this value will override the Processing value set
up with the LogParams command. This parameter controls which calibration steps are
applied to data before they are filtered and saved:
0 - raw, unprocessed
1 - pixel adjustments
2 - dark-current compensation
3 - normalized by integration time
4 - engineering unit scaling (full calibration)
A pair of control-c characters received through the serial port during execution of
LOGRANGE will abort the process.
9.4.9 RAW FirstPixel LastPixel PixelIncrement Channel
Displays the most recent spectrum collected with INT or AUTO. Does not apply
the filter, but does apply the pixel limits set with FILTPARAMS. If FirstPixel, LastPixel, or PixelIncrement are specified, then these values are used in place of the
FILTPARAMS limits. If Channel is specified (or an asterisk "*" for all channels), the
most recent spectrum from that channel is shown. Press Control-C, or send an ASCII
code 03 to break out of the listing.
9.4.10 START Command…
If Command… is specified, it is executed every SampleCycle seconds, as specified in the LOGPARAMS command. Control-C, or switching the Trigger switch to OFF,
stops the loop. Command… may also be the name of a command file, which would be
executed every SampleCycle seconds. A STOP command in the command file will also
break the loop.
If no command is specified, the LOG command executes every SampleCycle seconds, collecting SampleDuration samples each time, as specified in the LOGPARAMS
command. When sampleDuration samples have been collected, the WaLRUS will go into
low-power sleep mode until SampleCycle seconds have passed since the beginning of the
previous collection. This is equivalent to switching the Trigger switch to "ON". ControlC, or switching the Trigger switch to OFF, stops automatic sampling.
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9.4.11 STOP
Halts data collection initiated by START.

9.5 File Operations
9.5.1 CAPTURE Filename
Opens the file named Filename, and copies lines of text to the file as they are
typed. Editing keys may be used to edit each line as it is typed. During editing, the
prompt changes to Capture>. The file is closed when a <control-z> character is received. CAPTURE automatically overwrites any previously existing file called Filename. The RadSoft Terminal cut and paste functions, on the Edit menu, may be used to
give this command considerable power.
9.5.2 COPY File1 File2
Copies the contents of File1 to File2.
9.5.3 COPY CON FileName or COPY CON: FileName
Synonymous with CAPTURE FileName.
9.5.4 DEL Filespec
Deletes the indicated file or files from the flash disk. Any combination of * and ?
wild cards that can be used with MS-DOS can be used with this command. The ? wildcard matches any single character, and * matches any group of characters. For example,
DEL,TEST?.* deletes any file whose name starts with “TEST”, followed by any single
character, and with any extension. TESTA.DAT, TEST2.BIN, TESTA and TESTT.X all
match; TEST12.DAT does not. DEL presents a list of files meeting that file specification,
and their sizes, then asks “Delete all the above files?”. If you press Y it will immediately
delete them. Pressing any other key will abort the command.
9.5.5 DIR Filespec
Lists all the files on the flash disk whose filenames are described by Filespec.
Filespec can contain MS-DOS wild cards such as “*” and “?.”
9.5.6 ERASE Filename
Synonymous with DEL Filename.
9.5.7 REN OldName NewName
Renames the file called OldName to NewName
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9.5.8 TYPE Filename Textmode ShowNames Delay
Transmits the contents of the file named Filename via the serial port. Filename
can contain wildcards. If Textmode is specified as 1 or “on” (default), then Carriage Returns and Line Feeds will be expanded to Carriage Return/Line Feed combinations. If
Textmode is specified as 0 or “off”, then the output will be pure binary. If ShowNames is
specified as 1 or “on” (default=”off”), then filename(s) precede the output from each file.
If Delay is specified, then the WaLRUS waits Delay milliseconds before displaying the
output.
9.5.9 YS [/Q] [/G] FileSpec
Initiates a batch file send using the YMODEM protocol. Sends all files whose
filenames match FileSpec, which can contain DOS wildcards such as "*" or "?". YS can
be forced to YMODEM-G (no error checking/recovery) with the /G option. The /Q option inhibits messages. To cancel a pending transfer, press <control-X> several times.
9.5.10 YR [/Q] [/G]
Initiates a batch file receive with automatic file naming using the YMODEM protocol. YR can be forced to YMODEMG (no error checking/recovery) with the /G option.
The /Q option inhibits messages. To cancel a pending transfer, press <control-X> several times.

9.6 Auxillary Serial Port Commands
9.6.1 SERCLOSE
Closes the 2nd serial port. Not implemented on all systems.
9.6.2 SEROPEN BaudRate
Opens the 2nd serial port at the specified baud rate. Data received from the 2nd
serial port will be sent to the first serial port. Not implemented on all systems.
9.6.3 SERSEND String
Sends string, including ANSI escape sequences to the 2nd serial port. Not implemented on all systems.

9.7 Debugging and Testing
9.7.1 FREEMEM
Displays the amount of RAM available (for debugging).
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9.7.2 SIM State
Turns on or off simulation mode. In simulation mode the actual spectrometer data
are ignored, and each integration results in a triangular spectrum whose overall amplitude
is proportional to the value of State. If State is 1, the amplitude will be based on a random value.

9.8 Help
9.8.1 ? Command or HELP Command
Displays information related to specified command. If no command is specified,
lists available commands.
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10 APPENDIX: COMMAND FILES
WaLRUS commands can be loaded and executed from files stored in its flash
memory, exactly as if they had been received on the serial port from a user. By convention, these files have the extension .cmd and are referred to as command files. They are
similar to MS-DOS batch files, with the addition that they may specify a real-time schedule for executing commands.
Most command files are executed by typing the file name of the command file,
minus the .CMD extension. Command files can also be executed with the RUNFILE
command. Upon startup, WaLRUS will automatically execute the file HYDRORAD.CMD, if
it exists.
Command files can be created and edited using a Windows text editor, then
downloaded into the WaLRUS through RadSoft Explorer.

10.1 General Format
Each line has one command followed by a carriage return and optional linefeed.
Commands have the same format they would have if entered in real time.

10.2 Simple Example
auto 1 20
auto 2 20
auto 3 20
The above example simply determines the optimal integration time for channels 1,
2, and 3. Nothing is saved to the flash memory.

10.3 Timed Command File Format
Timed commands are preceded by a time in the form HH:MM (hours and
minutes), with a comma separating the time from the command. Note that whereas
command arguments may be separated with a space or comma, scheduled commands
MUST be separated from their times by a comma only.
Lines that contain a time, but no command, instruct WaLRUS to repeat the last
executed command at the designated time.
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10.4 Execution
When a file is run, WaLRUS begins by executing commands in the sequence they
are found in the file. If the file contains no timed commands, WaLRUS simply executes
them once in order, then closes the file and returns to interactive mode.
When WaLRUS encounters a scheduled command, it goes into low-power sleep
mode until the scheduled time, then wakes and executes the command. On its first pass
through the file, WaLRUS will skip any commands whose times have passed.
WaLRUS continues executing commands in sequence; unscheduled commands as
soon as they are read, and scheduled commands according to their designated times.
When it reaches the end of the file, or if all the schedule times have already
passed, WaLRUS will return to the first scheduled command in the file, and wait for that
time to arrive on the following day.
If a file contains no timed commands, WaLRUS will execute all the untimed
commands once, then return to the WaLRUS> prompt. If the file contains one or more
timed commands it will repeat the schedule every day until halted by the user.

10.5 Halting Execution
To halt execution of a command file, press <control-C>. You may need to repeat this several times, depending on the command being executed.

10.6 Testing
WaLRUS command files are essentially computer programs, and it can be surprisingly easy to create "bugs" in them. Before deploying a command file of any complexity
you should test it to verify it that it behaves as you intend. If your file includes long periods of sleep, you can accelerate its execution by pressing a key (not control-C, unless you
want to halt execution) once or twice to wake it from each sleep. It will detect that it
woke early, and display the message "sleep interrupted", but will nevertheless continue
with the next command, then sleep until the next scheduled time. You can also interrupt
time-consuming LOGAUTO, LOGFIXED and LOGRANGE commands, without halting
file execution, by pressing <control-C> once during the command.

10.7 Timed Examples
10.7.1 Timed Example 1
20:00,logauto 600
21:00,logauto 600
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22:00,logauto 300
logfixed 10000
23:30,logfixed 100
This file will do LOGAUTO,600 at 8PM and 9PM, Sleeping after it’s done each
one. At 10PM it will do LOGAUTO,300 immediately followed by LOGFIXED,10000,
then sleep until 11:30PM and do LOGFIXED,100. Then it will sleep until 8:00 the following day. It will repeat this cycle daily until instructed to do otherwise.

10.7.2 Timed Example 2
intparams,20,1000
0:00,logrange,20,1000,2
6:00,logauto,300 SECONDS
7:00
8:00
9:00
10:00
11:00
12:00
logfixed,10000
Note that example 2 starts with an untimed line. Untimed lines that appear before
the first timed line are executed only once each time the file is opened, whereas timed
commands are repeated each day. Once all the untimed lines are done, the program waits
for the first timed line whose time has not yet past. So if you were to start this file at
5:00, it would execute intparams,20,1000, then wait until 6:00 and do that line.
Lines that have a time but no command will repeat the last command that appears
before it in the file. If you started example 2 at 8:30, it would do the untimed line, then at
9:00 it would do LOGAUTO,300.
After doing LOGAUTO,300 at 12:00 in this file, then LOGFIXED,10000, WaLRUS will sleep until 0:00 the next day, then do LOGRANGE,20,1000,2.

10.7.3 Timed Example 3
intparams,20,10000
filtparams,100,1000,10
00:00,logrange,20,13000,5
6:00,logauto,600 SECONDS
7:00
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8:00
9:00
10:00
11:00
12:00
13:00
14:00
15:00
16:00
17:00
18:00
19:00
20:00
21:00
When it is first started this file will do the INTPARAMS and FILTPARAMS
commands, then wait for the next listed hour to start. It will collect 10 minutes (600 seconds) of data every hour during daylight hours, and a range of dark integrations every
midnight.
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